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Il sistema di lezioni a distanza del Master in Tecnologie 
Internet dell’Università di Pisa è stato avviato nel 2009, con 
lo scopo di consentire agli studenti-lavoratori la fruizione 
delle lezioni teoriche in diretta e differita. Il sistema si 
caratterizza per essere di semplice impiego e gestione, per 
essere basato su software libero e su strumenti hardware dal 
costo molto contenuto, e per produrre registrazioni di alta 
qualità e con occupazione di spazio molto ridotta. Il presente 
articolo fornisce i principali elementi progettuali e 
implementativi per consentirne la messa in opera, nonché dei 
riscontri sperimentali relativi ad un impiego pluriennale. 

1. Motivazione e analisi dei requisiti  
Nel Dicembre 2008 c’è stato un aumento notevole di studenti-lavoratori iscritti 

al Master in Tecnologie Internet dell’Università di Pisa [Master.IT 2013]. Si tratta 
di un Master nato nel 2003 rivolgendosi principalmente a persone laureate con il 
vecchio ordinamento e rimaste inoccupate, ma in seguito diventato di interesse 
crescente per i lavoratori. Esso è gestito dal Dipartimento di Ingegneria 
dell'Informazione [UNIPI-DII 2013] nell'ambito di una convenzione con l'Istituto di 
Informatica e Telematica dell'Area di Ricerca del CNR di Pisa [CNR-IIT 2013], e 
con il patrocinio del Registro.IT. 

In previsione di orientarsi verso la categoria dei lavoratori negli anni a venire, 
nel 2008 è stato deciso di mettere in opera un sistema informatico per le lezioni 
a distanza, specificatamente finalizzato alla fruizione in diretta e differita delle 
lezioni. È nata quindi l’esigenza di poter gestire strumenti software e hardware in 
tempi rapidi, tenendo conto delle limitate risorse umane a disposizione, e 
facendo in modo che tale rapidità di attivazione non possa venire a scapito della 
qualità e dell’efficienza. In quella occasione i principali “desiderata” del sistema, 
stabiliti dal Consiglio del Master a seguito di interviste a studenti e docenti, sono 
stati i seguenti. 
(i) Il sistema deve funzionare solo per le lezioni teoriche, dal momento che le 

attività di laboratorio richiedono la presenza fisica.  
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trasmissione più efficienti, e integrando diversi prodotti in modo da realizzare un 
sistema che svolge esclusivamente le funzionalità richieste. Nella prossima 
sezione forniremo la soluzione, completa di tutte le caratteristiche hardware e 
software, che viene ancora oggi adoperata [Masterit 2013]. 

2. Visione d’insieme 
La fruizione delle lezioni a distanza (in tempo reale o registrate) nel Master si 

basa su software di acquisizione continua dello schermo del PC docente, e 
dell'audio annesso. Pertanto, si suppone che il docente parli costantemente a un 
microfono, e svolga la lezione tramite presentazioni in formato elettronico. In 
particolare, per illustrare in modo interattivo le proprie spiegazioni egli può 
tracciare dei disegni a mano libera, adoperando una opportuna penna digitale. 

La Fig. 1 schematizza quanto descritto. Il docente (nell'edificio di destra) 
presenta la propria lezione su slide in formato elettronico, con l'ausilio di 
microfono e penna digitale. Alcuni studenti assistono alla lezione direttamente in 
aula. Altri studenti (in alto a sinistra in figura), in contemporanea, ricevono in 
streaming l'audio e video del PC docente. In parallelo, viene registrato un video 
di quanto trasmesso in streaming. A fine giornata, tale video viene trasferito su 
un web server (indicato come "www" in figura), in modo che altri studenti (in 
basso a sinistra) potranno successivamente scaricarlo e visionarlo. 

 

Fig. 1 – Lezioni a distanza, visione d’insieme 
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(ii) Il sistema deve essere quasi invisibile per i docenti, che devono poter 

continuare a svolgere le lezioni rivolgendosi agli studenti presenti in classe. 
Per questo motivo sono escluse forme comunicazione interattiva con gli 
studenti a distanza, quali ad esempio la chat. 

(iii) Il sistema deve consentire una fruizione in diretta affidabile e fluida, resa 
possibile con una normale connessione adsl e un normale portatile con 
connessione wi-fi. 

(iv) Il sistema deve consentire una registrazione delle lezioni molto efficiente, 
con file di dimensioni contenute. Ciò al fine di consentire il download intero 
delle registrazioni anche su dispositivi con risorse hardware limitate, come 
netbook e tablet, e al fine di poter successivamente vedere le registrazioni 
anche in assenza di connessione (ad esempio durante viaggi in treno). 

(v) Il sistema deve richiedere il minimo impegno di gestione, svolgendo le 
operazioni in modo quasi del tutto automatizzato. 

(vi) Il sistema deve basarsi su software libero, sia lato client sia lato server. 
(vii) Il sistema deve basarsi su strumenti hardware dai costi contenuti. 

 
Da una prima analisi dei requisiti, e da prime prove sperimentali svolte con 

studenti e docenti [Cavalli et al. 2010][Di Lecce et al. 2010], sono emerse le 
seguenti caratteristiche che il sistema dovrebbe avere. 
(a) Registrare lo schermo della postazione docente, e la voce del docente, 

escludendo registrazioni del volto del medesimo. In tal modo il video è 
sintetico, ossia non composto da acquisizione di immagini ambientali. Tale 
caratteristica consente notevole efficienza nella trasmissione e nella 
registrazione del video. Infatti, molti docenti basano le lezioni teoriche su 
lucidi o su testo scritto alla lavagna, ad avanzamento molto lento rispetto a 
un video tradizionale. 

(b) Basare l’acquisizione della voce su un microfono wireless ad alta efficienza 
energetica e alta qualità di trasmissione, e quasi invisibile per il docente, 
considerate le numerose ore di lezione. 

(c) Sostituire la lavagna con qualcosa di molto simile, come la scrittura su carta 
tramite penna a inchiostro. In questo contesto le tavolette grafiche sono state 
subito escluse, dal momento che richiedono una certa perizia nello scrivere 
guardando lo schermo. Anche gli schermi touch sono stati esclusi, sia per il 
radicale cambiamento che portano nelle abitudini del docente, rispetto allo 
scrivere su carta, sia per il maggiore costo. 
 
Da una prima indagine sugli strumenti integrati già esistenti in commercio, è 

emerso che essi hanno una manutenzione non indifferente (ad esempio, in 
termini di account, di iscrizione ai corsi, ecc.), forniscono un pacchetto di servizi 
non decomponibili (tipicamente condivisione desktop, condivisione documenti, 
webcam, chat room, e cosi via) la cui gestione è improponibile per il docente. 
Difatti, il docente desidera poter continuare a svolgere la lezione in modo 
convenzionale. Inoltre, essendo strumenti integrati, non è possibile poter 
configurare parametri critici quali ad esempio il codec video e il protocollo di 
streaming, e per questo possono esserci problemi di efficienza e affidabilità di 
trasmissione. È stato deciso pertanto di partire “dal basso” fissando i protocolli di 
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Fig. 2 – Esempio di lezione registrata con impiego di penna digitale 

4. Configurazione del sistema 
Nella presente sezione sono indicati tutti i settaggi adoperati nel sistema. 

Essi sono frutto di sperimentazione accurata svolta presso il CNR-IIT, dove si 
svolgono le lezioni del Master. Prima però di esporre i settaggi, nella seguente 
sottosezione saranno motivati alcuni parametri fondamentali. 

4.1 Principali motivazioni sulla scelta dei parametri 
4.1.1 Video e audio registrato 

Nel software di registrazione, CamStudio, è possibile adoperare vari codec 
video. Usualmente per video ottenuti da acquisizioni ambientali, i codec migliori 
adottano tecniche di compressioni lossy (a perdita di informazione) in modo da 
poter ridurre i dati necessari da trasmettere. Nel caso di video sintetici molto 
lenti, ossia composti da immagini generate sinteticamente, CamStudio.org ha 
realizzato un codec lossless (senza perdita di informazione), con un algoritmo di 
compressione noto come LZO (Lempel–Ziv–Oberhumer). Il video viene inoltre 
acquisito e riprodotto con un frame rate di soli 5 fotogrammi al secondo, 
sufficiente a catturare con fluidità i movimenti del mouse e della penna. Poiché 
lo sfondo del video è spesso statico, i video cosi prodotti e codificati sono 
ulteriormente comprimibili tramite la codifica di compressione RAR, diventando 
da un terzo a un quarto delle dimensioni di partenza. Si noti infine che, essendo 
una registrazione full screen, è importante diminuire risoluzione e profondità 
dello schermo a 800x600 e 16 bit, rispettivamente.  

Formati audio compressi, come mp3, producono una leggera 
desincronizzazione tra audio e video. Per questo motivo l’audio non è 
compresso, ma semplicemente sottocampionato. Difatti, la voce umana nel 
dialogo (quindi, non nel canto) può essere campionata con frequenza 11 kHz, 
mono, e profondità 16-bit per campione. Il formato adottato è PCM (21 kbit/s), 
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3. Applicazioni e strumenti per studenti e docenti  

Presentiamo brevemente gli strumenti software che studenti e docenti 
devono impiegare.  

Il software di registrazione delle lezioni, CamStudio [Camstudio 2013], è 
adoperato esclusivamente dal docente, e si presenta con una interfaccia 
estremamente semplice, basata su tre pulsanti (start/pause/stop). La 
registrazione viene salvata in forma di file avi, con opportuni formati video e 
audio ottimizzati per avere dimensioni contenute. Per produrre registrazioni di 
dimensione ridotta, lo schermo viene settato con risoluzione e profondita’ 
minima. Al termine della giornata, uno script comprime i file in formato RAR, li 
rinomina in accordo a un formato prestabilito, e li trasferisce su un web server. 
Sul web server, una pagina html statica è predisposta a inizio del ciclo di lezioni 
per poter collegare tutti i file video che saranno man mano prodotti. 

Per la fruizione in diretta ci sono due diversi software da usare, che non 
richiedono alcuna gestione da parte del docente. Essi sono RealVNC [RealVNC 
2013] per l’accesso allo schermo del PC docente, e VLC Media Player 
[Videolan 2013] per l’accesso all’audio del PC docente. Il docente possiede un 
microfono da bavero a radiofrequenza, facente parte di un kit Audio Technica 
[Audio Technica  2013]. Il kit è composto da un trasmettitore body pack con 
microfono lavalier a condensatore e un ricevitore fisso true diversity con cavo 
jack 2 mt per il collegamento del ricevitore al computer (ingresso della scheda 
audio). Il costo approssimativo del kit è di circa 350 Euro. La durata batterie del 
trasmettitore è di nove ore circa. Le batterie sono normali pile AA ricaricabili in 
12 ore circa. Sono state sperimentate anche soluzioni basate su microfoni con 
trasmettitore bluetooth e ricevitore bluetooth-USB, che non hanno la affidabilità, 
la qualità e la autonomia necessaria, oltre a rendere la registrazione più 
impegnativa per il computer (la porta USB non è una porta dedicata, come 
l’ingresso della scheda audio).  

Lo studente che intende connettersi in diretta dovrà adoperare le medesime 
applicazioni in configurazione client: RealVNC e VLC Media Player. 

Per visualizzare i video delle lezioni in differita, è possibile adoperare un 
qualsiasi player video, una volta installato il CamStudio codec sul proprio PC. I 
player più affidabili per il codec scelto risultano, nell’ordine, SMPlayer, VLC 
Media Player, e Windows Media Player. 

I docenti che intendono annotare le proprie presentazioni o disegnare come 
su una lavagna, adoperano la penna E-pens [E-pens 2013]. Si tratta di una 
penna a inchiostro comune (costo ricarica pochi euro, e durata pluriennale) e 
comuni batterie da orologio V392 (del costo di alcuni euro, con durata di qualche 
mese). Abbinata alla penna c’è una pinza ricevente detta unità base, che cattura 
in tempo reale ciò che si scrive sul foglio e lo trasmette via cavo USB. Il costo 
della penna è inferiore a 100 Euro. La Fig. 2 mostra un fotogramma di lezione 
registrata durante l’impiego della penna digitale. 

In conclusione, il costo complessivo degli strumenti hardware si aggira 
attorno a 450 Euro complessive. 
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4.2.2 VNC Server 
9. Scaricare VNC Server, e installarlo con le opzioni prestabilite. 
10. Tasto destro sull'icona VNC sulla barra di windows; 

→ Options...; → Authentication; 
→ VNC Password Authentication; → Configure; 
→ Inputs → togliere tutte le selezioni; 
→ Sharing → Always treat new connections as shared; 
→ Desktop → Remove wallpaper, background pattern; 

→ Disable UI effects selezionati. 

4.2.3 VLC Media Player 
11. Scaricare VLC media Player, e installarlo con le opzioni prestabilite. 
12. Media → Apri dispositivo di acquisizione; 

→ Nome del dispositivo video: nessuno; 
→ Nome del dispositivo audio: <scheda audio>; 
→ Opzioni Avanzate: valore cache in ms : 50; 
→ Mostra altre opzioni: cache: 50 ms; 
→ <cliccare sulla freccia in basso accanto a Play>; 
→ Flusso → HTTP Indirizzo: <indirizzo IP server> Porta:8082; 
→ Incapsulazione: MPEG-TS; 
→ Codifica Audio: audio -> MPEG Audio, 32 kbit/s, canali: 1; 
→ Mantenere aperto stream output; 
→ Clicca su STREAM. 

4.3 Operazioni e settaggi e Installazione PC studente 
4.3.1 VNC Viewer 
13. Scaricare VNC Viewer ed eseguirlo. 
14. Cliccare su Options, togliere la selezione in Auto select (ZRLE),  

scegliere Low color level (64 colors). 
15. Passare alla scheda Inputs, e togliere tutte le selezioni → OK. 
16. Digitare su Server: <indirizzo ip server>. 

4.3.2 VLC Media Player 
17. Scaricare VLC Media Player e installarlo con le opzioni prestabilite. 
18. Menu Media → Apri rete; 

→ Protocollo: http;   → Indirizzo: <indirizzo ip>:8082; 
→ Mostra altre opzioni → Cache:50ms. 

19. → Play. 

4.3.3 Tight VNC (alternativa a 4.3.1) 
20. Scaricare Tight VNC in versione java, VncViewer.jar. 
21. Da shell digitare: 

 java -classpath ./VncViewer.jar VncViewer HOST <ind. ip> PORT 5900. 
22. Options, Encoding: ZRLE, Restricted colors: Yes, View only: Yes. 
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ossia con campionamento regolare a intervalli uniformi, e campione quantizzato 
al valore più vicino in una scala digitale. 

4.1.2 Video e audio in diretta 
Nel software di accesso video in diretta, VNC viewer, è possibile 

adottare la codifica dello schermo ZRLE, che sta per Zlib1 Run-Length 
Encoding, e combina zlib compression e altre tecniche, quali tiling, palettisation 
e run-length encoding. In sostanza l’area dello schermo è divisa in rettangoli. 
Ogni rettangolo inizia con un campo di 4 byte, ed è seguito da tanti byte di dati 
compressi con zlib. Un singolo stream “oggetto zlib” è adoperato per una data 
connessione di protocollo RBF (“Remote framebuffer”, protocollo di accesso 
remoto a interfacce grafiche), in modo che i rettangoli ZRLE devono essere 
codificati e decodificati strettamente in ordine. In VNC viewer è anche possibile 
ridurre il numero di colori, e questo consente di ricevere meno informazione e 
quindi di mantenere un aggiornamento in tempo reale sul client, anche nel caso 
di connessione con banda ridotta. 

Similmente al caso della registrazione audio, anche nel caso della 
trasmissione audio in diretta si è adottato un basso campionamento (32 kbit/s, 
mono canale), con formato contenitore MPEG Audio. 

4.2 Operazioni e settaggi nella installazione PC docente 
4.2.1 CamStudio 
1. Scaricare CamStudio, e installarlo con le opzioni prestabilite. 
2. Scaricare CamStudioCodec, e installarlo con le opzioni prestabilite. 
3. Settare lo schermo del PC a risoluzione 800x600 e profondità 16 bit. 
4. Menu Region → Full Screen. 
5. Menu Options → Video Options → CamStudio Lossless Codec v1.4; 

→ Quality: 1 → Configure: LZ0, level 9; 
→ Set Key Frames Every 200 frames; 
→ Capture Frames Every 200 milliseconds; 
→ Playback Rate 5 frames/second. 

6. Menu Options → record audio from microphone; 
→ Audio Options → Audio Options for Microphone; 
 → Recording Format: 11,025 kHz, mono, 16-bit; 
 → Choose Compressed Format → PCM (21 kbit/s); 
 → Togliere la spunta Interleaving; 
 → NON scegliere MCI (impedisce la compressione audio). 

7. Menu Options → Program Options; 
 → Play AVI file when recording stops; → Do not play AVI file 

→ Temporary directory for recording; 
→ Use user specified directory...; 

→ Recording Thread Priority; → Time Critical; 
→ Name of AVI file → Automatic file naming; 

8. Menu View → Compact view. 
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Le Fig. 4 e 5 mostrano l’andamento dei download delle lezioni nel primo 
periodo del 2012. In particolare, dalla Fig. 4 si può notare come il servizio risulti 
regolarmente fruito dagli studenti, con sessioni molto brevi, di 3.5 minuti in 
media, come risulta dalla Fig. 5. Andamenti simili sono stati riscontrati negli anni 
precedenti, con numero di lavoratori variabili tra venti e trenta studenti. Per tale 
motivo il server web può girare su una macchina virtuale molto modesta.   

 
Fig. 4 – Andamento degli accessi nel primo periodo del 2012 

 

Fig. 5 – Tempo medio di permanenza sulla pagina nel primo periodo del 2012 

Mentre l’accesso alle registrazioni avviene da parte della totalità degli 
studenti-lavoratori, l’accesso in diretta avviene da parte di pochi studenti, mai più 
di cinque, sovente diversi giorno per giorno. Per tale motivo è stato sufficiente 
adoperare un normale personal computer come postazione docente. La Fig. 6 
caratterizza due indicatori importanti dal punto di vista didattico: la penetrazione 
e la prestazione didattica, che misurano il livello di adozione della soluzione a 
distanza e il grado di utilità ai fini del superamento dell’esame. I dati sono stati 
ottenuti tramite un questionario con cinque domande (riassunte a destra in 
figura) a risposta singola su scala a cinque valori (rappresentati a sinistra in 
figura, sull’asse delle ordinate). Sono stati creati tre cluster sulla base della 
frequentazione delle lezioni (dato ricavabile dalla prima domanda), e per ogni 
cluster è stato calcolato e rappresentato solo il valor medio: i) i lavoratori (a 
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5. Valutazione delle prestazioni del sistema 

Sin dagli inizi della sua applicazione, il sistema di lezioni a distanza è stato 
oggetto di accurato monitoraggio [Impedovo et al. 2010]. La Tab. 1 mostra le 
principali caratteristiche dei video registrati, nel periodo 2008-2012. In 
particolare, sono state svolte in media: circa 90 lezioni annue (II colonna), 
corrispondenti a 180 ore annue (III colonna), per un totale di 25782 MB (non 
compressi, IV colonna), ossia solo 8893 MB compressi (V colonna). Ciò significa 
che un intero anno di registrazione del Master entra in due normali DVD. Le 
ultime due colonne riguardano i MB (non compressi e compressi) per ora di 
registrazione: solo 49 MB per ora nel caso di dati compressi, con un rapporto di 
circa un terzo rispetto ai dati non compressi. 

Tab. 1 – Principali caratteristiche dei video registrati, dal 2008 al 2012. 

A.A. N. LEZ HH LEZ. TOT MB TOT MB RAR  MB/HH MB RAR/HH 
2008/09 88 182.50 23088.82 8342.68 126.51 45.71 
2009/10 94 180.00 22105.61 9073.65 122.81 50.41 
2010/11 93 178.33 23875.75 10002.53 133.89 56.09 
2011/12 86 179.17 34059.47 8153.88 190.10 45.51 
MEDIA 90.25 180.00 25782.41 8893.19 143.33 49.43 

La Fig. 3 evidenzia in modo tangibile l’efficienza della compressione RAR, 
visualizzando, anno per anno, le dimensioni complessive (in GB) dei dati 
compressi (in nero) e non compressi (in blu). Sopra ogni colonna, vengono 
altresì mostrati i MB per ora. È degno di nota, e di possibili investigazioni, il fatto 
che nell’ultimo anno ci sia stato un aumento considerevole della occupazione 
totale dei dati registrati (attorno a 35 GB), al quale però non corrisponde un 
aumento dei dati compressi. 

 

Fig. 3 – Andamento del rapporto di compressione su quattro anni 



	
ISBN 978-88-98091-10-2	 831

Un sistema di lezioni a distanza basato su criteri di semplicità, efficienza ed economicità 
 

Le Fig. 4 e 5 mostrano l’andamento dei download delle lezioni nel primo 
periodo del 2012. In particolare, dalla Fig. 4 si può notare come il servizio risulti 
regolarmente fruito dagli studenti, con sessioni molto brevi, di 3.5 minuti in 
media, come risulta dalla Fig. 5. Andamenti simili sono stati riscontrati negli anni 
precedenti, con numero di lavoratori variabili tra venti e trenta studenti. Per tale 
motivo il server web può girare su una macchina virtuale molto modesta.   

 
Fig. 4 – Andamento degli accessi nel primo periodo del 2012 

 

Fig. 5 – Tempo medio di permanenza sulla pagina nel primo periodo del 2012 

Mentre l’accesso alle registrazioni avviene da parte della totalità degli 
studenti-lavoratori, l’accesso in diretta avviene da parte di pochi studenti, mai più 
di cinque, sovente diversi giorno per giorno. Per tale motivo è stato sufficiente 
adoperare un normale personal computer come postazione docente. La Fig. 6 
caratterizza due indicatori importanti dal punto di vista didattico: la penetrazione 
e la prestazione didattica, che misurano il livello di adozione della soluzione a 
distanza e il grado di utilità ai fini del superamento dell’esame. I dati sono stati 
ottenuti tramite un questionario con cinque domande (riassunte a destra in 
figura) a risposta singola su scala a cinque valori (rappresentati a sinistra in 
figura, sull’asse delle ordinate). Sono stati creati tre cluster sulla base della 
frequentazione delle lezioni (dato ricavabile dalla prima domanda), e per ogni 
cluster è stato calcolato e rappresentato solo il valor medio: i) i lavoratori (a 

DIDAMATICA 2013 
 
5. Valutazione delle prestazioni del sistema 

Sin dagli inizi della sua applicazione, il sistema di lezioni a distanza è stato 
oggetto di accurato monitoraggio [Impedovo et al. 2010]. La Tab. 1 mostra le 
principali caratteristiche dei video registrati, nel periodo 2008-2012. In 
particolare, sono state svolte in media: circa 90 lezioni annue (II colonna), 
corrispondenti a 180 ore annue (III colonna), per un totale di 25782 MB (non 
compressi, IV colonna), ossia solo 8893 MB compressi (V colonna). Ciò significa 
che un intero anno di registrazione del Master entra in due normali DVD. Le 
ultime due colonne riguardano i MB (non compressi e compressi) per ora di 
registrazione: solo 49 MB per ora nel caso di dati compressi, con un rapporto di 
circa un terzo rispetto ai dati non compressi. 

Tab. 1 – Principali caratteristiche dei video registrati, dal 2008 al 2012. 

A.A. N. LEZ HH LEZ. TOT MB TOT MB RAR  MB/HH MB RAR/HH 
2008/09 88 182.50 23088.82 8342.68 126.51 45.71 
2009/10 94 180.00 22105.61 9073.65 122.81 50.41 
2010/11 93 178.33 23875.75 10002.53 133.89 56.09 
2011/12 86 179.17 34059.47 8153.88 190.10 45.51 
MEDIA 90.25 180.00 25782.41 8893.19 143.33 49.43 

La Fig. 3 evidenzia in modo tangibile l’efficienza della compressione RAR, 
visualizzando, anno per anno, le dimensioni complessive (in GB) dei dati 
compressi (in nero) e non compressi (in blu). Sopra ogni colonna, vengono 
altresì mostrati i MB per ora. È degno di nota, e di possibili investigazioni, il fatto 
che nell’ultimo anno ci sia stato un aumento considerevole della occupazione 
totale dei dati registrati (attorno a 35 GB), al quale però non corrisponde un 
aumento dei dati compressi. 

 

Fig. 3 – Andamento del rapporto di compressione su quattro anni 



	 DIDAMATICA 2013
832	 Pisa, 7-8-9 Maggio  - Area della Ricerca CNR

Un sistema di lezioni a distanza basato su criteri di semplicità, efficienza ed economicità 
 

ispira a criteri di semplicità ed efficienza. Inoltre, con un costo complessivo 
dell’hardware attorno a 450 Euro, e con prodotti software interamente open 
source (GPL), il sistema persegue anche criteri di economicità. Dati sperimentali 
raccolti su un impiego pluriennale dimostrano il costante utilizzo e la efficienza di 
registrazione: in media 49.4 MB di spazio disco per ora di registrazione. Infine, il 
sistema mostra un ottimo livello di penetrazione e prestazione in termini didattici 
sia tra i lavoratori sia tra gli studenti. Su richiesta, è possibile accedere al 
sistema all’indirizzo [Masterit 2013] e scaricare dei video dell’anno corrente. 
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sinistra) quasi mai presenti alle lezioni teoriche; ii) gli studenti (a destra) di solito 
presenti; iii) un cluster di persone in situazione intermedia (al centro) 
comprendente principalmente lavoratori part-time e studenti fuori sede. In figura, 
i cluster sono rappresentati sull’asse delle ascisse. 

 

Fig. 6 – Penetrazione e prestazione didattica del sistema 

I risultati mostrano chiaramente che, al diminuire del livello di frequentazione 
(curva blu: lezioni fruite frontalmente) si alzano sia il livello di prestazione (curva 
azzurra: utilità dello strumento per il superamento dell’esame) che di 
penetrazione (le tre curve rimanenti). Il servizio con maggiore penetrazione è 
quello delle lezioni in differita, fruite in due diverse modalità: i) integralmente, 
quale primo studio (curva verde); ii) parzialmente, su specifiche parti del 
programma (curva viola), quale ulteriore ripasso o approfondimento. È 
importante precisare che anche i lavoratori hanno un minimo obbligo di 
frequenza (variabile a seconda dell’anno accademico) e pertanto non hanno la 
necessità di fruire da remoto di tutte le lezioni. Il servizio con minore 
penetrazione è quello delle lezioni fruite da remoto e in diretta (curva rossa). Al 
tal proposito, occorre precisare che gli argomenti svolti alle lezioni teoriche sono 
ripresi nelle esercitazioni di laboratorio della settimana successiva. Pertanto per 
il lavoratore non c’è l’effettiva esigenza di fruire in tempo reale di una data 
lezione teorica, avendo tutto il tempo per farlo. In generale, la fruizione da 
remoto e in diretta viene adoperata occasionalmente da chi non può essere 
fisicamente presente in aula per circostanze particolari, ma intende comunque 
dedicare quelle ore e non altre allo studio della teoria.  

6. Conclusioni 
L’articolo illustra un sistema di lezioni a distanza realizzato per favorire 

l’ingresso di studenti-lavoratori all’interno del Master in tecnologie Internet 
dell’Università di Pisa, e adoperato con successo sin dal 2009. Il sistema ha 
alcune proprietà che lo rendono applicabile in una situazione di genere, quella 
universitaria e scolastica, caratterizzata da limitate risorse umane a disposizione 
per la gestione e limitata possibilità di spesa. La progettazione del sistema si 
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sinistra) quasi mai presenti alle lezioni teoriche; ii) gli studenti (a destra) di solito 
presenti; iii) un cluster di persone in situazione intermedia (al centro) 
comprendente principalmente lavoratori part-time e studenti fuori sede. In figura, 
i cluster sono rappresentati sull’asse delle ascisse. 

 

Fig. 6 – Penetrazione e prestazione didattica del sistema 

I risultati mostrano chiaramente che, al diminuire del livello di frequentazione 
(curva blu: lezioni fruite frontalmente) si alzano sia il livello di prestazione (curva 
azzurra: utilità dello strumento per il superamento dell’esame) che di 
penetrazione (le tre curve rimanenti). Il servizio con maggiore penetrazione è 
quello delle lezioni in differita, fruite in due diverse modalità: i) integralmente, 
quale primo studio (curva verde); ii) parzialmente, su specifiche parti del 
programma (curva viola), quale ulteriore ripasso o approfondimento. È 
importante precisare che anche i lavoratori hanno un minimo obbligo di 
frequenza (variabile a seconda dell’anno accademico) e pertanto non hanno la 
necessità di fruire da remoto di tutte le lezioni. Il servizio con minore 
penetrazione è quello delle lezioni fruite da remoto e in diretta (curva rossa). Al 
tal proposito, occorre precisare che gli argomenti svolti alle lezioni teoriche sono 
ripresi nelle esercitazioni di laboratorio della settimana successiva. Pertanto per 
il lavoratore non c’è l’effettiva esigenza di fruire in tempo reale di una data 
lezione teorica, avendo tutto il tempo per farlo. In generale, la fruizione da 
remoto e in diretta viene adoperata occasionalmente da chi non può essere 
fisicamente presente in aula per circostanze particolari, ma intende comunque 
dedicare quelle ore e non altre allo studio della teoria.  

6. Conclusioni 
L’articolo illustra un sistema di lezioni a distanza realizzato per favorire 

l’ingresso di studenti-lavoratori all’interno del Master in tecnologie Internet 
dell’Università di Pisa, e adoperato con successo sin dal 2009. Il sistema ha 
alcune proprietà che lo rendono applicabile in una situazione di genere, quella 
universitaria e scolastica, caratterizzata da limitate risorse umane a disposizione 
per la gestione e limitata possibilità di spesa. La progettazione del sistema si 




